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Abstract

Terminal Services Web Access (TS Web Access) is a role service in the Windows Server® 2008 operating system that enables users to access RemoteApp™ programs or the full terminal server desktop from a Web site. By default, the TS Web Access Web site enables you to point to a single terminal server or to a single terminal server farm to populate the list of RemoteApp programs that appear on the site. If you have multiple terminal servers or multiple terminal server farms, you can use Windows® SharePoint® Services to create a single Web access point for RemoteApp programs and full terminal server desktop connections that are available on different terminal servers.
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Customizing TS Web Access by Using Windows SharePoint Services

Terminal Services Web Access (TS Web Access) is a role service in the Windows Server® 2008 operating system that enables users to access RemoteApp™ programs or the full terminal server desktop from a Web site. By default, the TS Web Access Web site enables you to point to a single terminal server or to a single terminal server farm to populate the list of RemoteApp programs that appear on the site. If you have multiple terminal servers or multiple terminal server farms, you can use Windows® SharePoint® Services to create a single Web access point for RemoteApp programs and full terminal server desktop connections that are available on different terminal servers. You can customize a Windows SharePoint Services site by adding multiple TS Web Access Web Parts, each pointing to a different terminal server or terminal server farm.

Prerequisites

Before you install Windows SharePoint Services, ensure that the server meets the following prerequisites:


The server must be running the release to manufacturing (RTM) version of Windows Server 2008 Standard, Windows Server 2008 Enterprise, Windows Server 2008 Datacenter or Windows Web Server 2008.

[image: image3.png]


Note 

This procedure does not work correctly with Windows Server 2008 Release Candidate (RC) 1.


The server must have the TS Web Access role service installed. For more information, see the "Install the TS Web Access role service" section of the Terminal Services RemoteApp Step-by-Step Guide (http://go.microsoft.com/fwlink/?LinkId=84895).

Installation procedure

To use Windows SharePoint Services to provide access to terminal servers through TS Web Access, you must complete the following procedures on the TS Web Access server:
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Note 

You must be logged on as a member of the local Administrators group to complete these procedures.

1.
Install .NET Framework 3.0
2.
Install Windows SharePoint Services 3.0 with Service Pack 1
3.
Register the Web Part's assembly and namespace as a Safe Control
4.
Create a folder to store the Web Part images, and assign folder permissions
5.
Add the Web Part to the Windows SharePoint Services site
Install .NET Framework 3.0

Before you can install Windows SharePoint Services, you must install .NET Framework 3.0, which is included as an installable feature in Windows Server 2008.
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To install .NET Framework 3.0

	1.
Start Server Manager. To open Server Manager, click Start, point to Administrative Tools, and then click Server Manager.

2.
In the Server Manager console tree, right-click Features, and then click Add Features.

3.
On the Select Features page, expand .NET Framework 3.0 Features.

4.
Select the .Net Framework 3.0 check box, and then click Next.

5.
Click Install.

6.
On the Installation Results page, verify that the installation succeeded, and then click Close.

7.
Close Server Manager.


Install Windows SharePoint Services 3.0 with SP1

To install Windows SharePoint Services on a Windows Server 2008-based computer, the required version is Windows SharePoint Services 3.0 with Service Pack 1 (SP1). You cannot install Windows SharePoint Services 3.0 without SP1 on a Windows Server 2008-based computer.
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Important 

This document covers the installation of Windows SharePoint Services as a stand-alone server. It does not cover installing Windows SharePoint Services as a Web front-end server for a Windows SharePoint Services farm. For more information about farm configuration, see the article "Deploy a simple farm on the Windows Server 2008 operating system (Windows SharePoint Services)" in the Microsoft Knowledge Base (http://go.microsoft.com/fwlink/?LinkId=106516). 
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To install Windows SharePoint Services 3.0 with SP1

	1.
Download Windows SharePoint Services 3.0 with SP1. To download the software, visit either of the following Web sites, depending on your operating system version:


Windows SharePoint Services 3.0 with SP1, 32-bit edition (http://go.microsoft.com/fwlink/?LinkId=106255)


Windows SharePoint Services 3.0 with SP1, 64-bit edition (http://go.microsoft.com/fwlink/?LinkId=106257)

2.
On the Download Center page, click Download.

3.
In the File Download - Security Warning dialog box, click Run to start the installation, or click Save to run the installation later.

4.
In the Internet Explorer - Security Warning dialog box, click Run to continue with the installation.

5.
On the Read the Microsoft Software License Terms page, review the terms of the agreement. If you accept the terms, select the I accept the terms of this agreement check box, and then click Continue.

6.
On the Choose the installation you want page, click Basic to install to the default location. (To install to a different location, click Advanced, specify the location that you want to install to on the Data Location tab, and then click Install Now.)

7.
When Setup finishes, a dialog box prompts you to complete the configuration of your server. Ensure that the Run the SharePoint Products and Technologies Configuration Wizard now check box is selected, and then click Close to continue.

The SharePoint Products and Technologies Configuration Wizard starts.

8.
On the Welcome to SharePoint Products and Technologies page, click Next.

9.
When you receive a warning message about services having to be restarted, click Yes to continue.

10.
On the Configuration Successful page, click Finish.

11.
When you are prompted to enter your credentials to access the Windows SharePoint Services site, click Cancel, and then close Internet Explorer.


Register the Web Part's assembly and namespace as a Safe Control

As a security measure, Windows SharePoint Services requires that you register the TS Web Access Web Part's assembly and namespace as a Safe Control in the Web.config file of the server.

The following procedure shows how to register the Web Part's assembly as a Safe Control for Windows SharePoint Services sites that use the default port 80.
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To register the Web Part's assembly and namespace as a Safe Control

	1.
Open an elevated command prompt. To do this, click Start, right-click Command Prompt, and then click Run as administrator.

2.
In the User Account Control dialog box, click Continue.

3.
At the command prompt, type the following command (where C:\ represents the drive where you installed Internet Information Services), and then press ENTER:

notepad C:\inetpub\wwwroot\wss\VirtualDirectories\80\web.config
4.
In the <SafeControls> section of the Web.config file, add the following line under the other SafeControl Assembly entries (as a single line):

<SafeControl Assembly="TSPortalWebPart, Version=6.0.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" Namespace="Microsoft.TerminalServices.Publishing.Portal" TypeName="*" Safe="True" AllowRemoteDesigner="True" />

5.
On the File menu, click Save, and then close the file.

6.
(Optional) To make the Web Part available to the SharePoint 3.0 Central Administration site, repeat this procedure for the Web.config file that is located in the following folder, where C:\ represents the drive where you installed Internet Information Services:

C:\inetpub\wwwroot\wss\VirtualDirectories\port_number\web.config
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Note 

The port_number placeholder represents the random port number that the SharePoint Central Administration site is configured to use, for example, port 36950. To determine the port number, either browse to the VirtualDirectories folder, or open Internet Information Services (IIS) Manager, locate and then click the SharePoint Central Administration v3 site, click Bindings in the Actions pane, and then view the port number in the Port column. (To open IIS Manager, click Start, point to Administrative Tools, and then click Internet Information Services (IIS) Manager.)


Create the folder path to store the Web Part image files

You must create a folder path to store the images for the TS Web Access Web Part. Additionally, you must grant the Network Service account the Full Control permission to the Images folder.
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To create the folder path and grant permissions to the Network Service account

	1.
Run the following commands from an elevated command prompt. Press ENTER after each command.

a.
Create the required folder path. To do this, run the following command:

mkdir "C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\wpresources\TSPortalWebPart\6.0.0.0__31bf3856ad364e35\images"
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Note 

If you type the command instead of copying it, ensure that you use two underscore characters in the "6.0.0.0__31bf3856ad364e35" folder name.

b.
Change directories to the 6.0.0.0__31bf3856ad364e35 folder. To do this, run the following command:

cd "C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\wpresources\TSPortalWebPart\6.0.0.0__31bf3856ad364e35"
c.
Assign the Network Service account the Full Control permission to the Images folder. To do this, run the following command:

icacls images /grant NetworkService:F
The command output should indicate that the file was successfully processed.

2.
Close the Command Prompt window.


Add the Web Part to a Windows SharePoint Services site

To add the TS Web Access Web Part to a Windows SharePoint Services site, you must first add the Web Part to the Web Part Gallery for the site. Then, you can add the Web Part and configure it to point to a specific terminal server or terminal server farm. If you have multiple terminal servers, you can add multiple Web Parts to the page, each pointing to a different terminal server or terminal server farm.

In the following procedure, the default Windows SharePoint Services site (on port 80) is used as an example.
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To add the Web Part to a Windows SharePoint Services site

	1.
In Internet Explorer, open the default Windows SharePoint Services site at the following location:

http://localhost/

2.
When you are prompted, enter your account credentials to log on to the site, and then click OK.

3.
If you are prompted that the content is being blocked by Internet Explorer, do one of the following.

If there is an Add button, follow these steps:

a.
Click Add to add the site to the Trusted sites zone (or see Internet Explorer Help for information about how to add the site to the Local intranet zone).

b.
In the Trusted sites dialog box, click Add again, and then click Close.

If there is no Add button, follow these steps:

a.
Click Close.

b.
On the Tools menu of Internet Explorer, click Internet Options.

c.
Click the Security tab.

d.
Under Select a zone to view or change security settings, click either the Local intranet zone or the Trusted sites zone, depending on your configuration, and then click Sites.

e.
Click Add to add the Web site to the zone, and then click Close.

f.
Click OK to close the Internet Options dialog box.

4.
Add the TS Web Access Web Part to the Web Part Gallery for the site. To do this, follow these steps:

a.
In the upper-right corner, click the Site Actions tab, and then click Site Settings.
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Note 

If the Site Settings menu does not expand, you may have to refresh the Web page or log on to the site again to view the settings.

b.
Under Galleries, click Web Parts.

c.
Under Web Part Gallery, click New.

d.
In the list of Web Parts, select the check box next to Microsoft.TerminalServices.Publishing.Portal.TSPortalWebPart. (This is the TSPortalWebPart.webpart file.)

e.
Near the top of the page, click Populate Gallery.

The TSPortalWebPart.webpart file should be listed in the Web Part Gallery.

5.
Click the Home tab.

6.
Add the TS Web Access Web Part to the page. To do this, follow these steps:

a.
Click the Site Actions tab, and then click Edit Page.

b.
Choose the location where you want to add the Web Part, and then click Add a Web Part.

c.
In the Add Web Parts -- Webpage Dialog dialog box, under All Web Parts, select the TSPortalWebPart check box, and then click Add.

The TSPortalWebPart Web Part will appear on the page.

7.
To configure the Web Part, click edit in the upper-right corner of the Web Part, and then click Modify Shared Web Part.

In the configuration pane that appears, you can configure settings such as the terminal server or terminal server farm from which to populate the Web Part, the title, and other appearance settings.

8.
When you are finished configuring the Web Part, click OK.

9.
When you are finished editing the site, in the upper-right corner, click Exit Edit Mode.

10.
To add other users who can access the site, click the Site Actions tab, and then click Site Settings. You can configure permissions by clicking one or more of the options under Users and Permissions. For more information, see the "About managing SharePoint groups and users" topic and the "Manage SharePoint groups" topic in Windows SharePoint Services Help.

11.
(Optional) If you want to add the TS Web Access Web Part to the Central Administration site, follow these steps:

a.
Ensure that the TS Web Access Web Part's assembly and namespace is registered as a Safe Control in the Web.config file for the Central Administration site.
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Note 

For more information, see step 6 of the Register the Web Part's assembly and namespace as a Safe Control procedure.

b.
Repeat steps 2 through 10 of this procedure for the Central Administration site. To open the Central Administration site, click Start, point to Administrative Tools, and then click SharePoint 3.0 Central Administration.


Additional references

For more information about Windows SharePoint Services 3.0 with SP1, see the following articles in the Microsoft Knowledge Base:


Description of Windows SharePoint Services 3.0 Service Pack 1 and of Windows SharePoint Services Language Pack 3.0 Service Pack 1 (http://go.microsoft.com/fwlink/?LinkId=106253)


Install a stand-alone server on Windows Server 2008 (Windows SharePoint Services) (http://go.microsoft.com/fwlink/?LinkId=106517)


Deploy a simple farm on the Windows Server 2008 operating system (Windows SharePoint Services) (http://go.microsoft.com/fwlink/?LinkId=106516)

For more information about how to deploy TS Web Access, see the Terminal Services RemoteApp Step-by-Step Guide (http://go.microsoft.com/fwlink/?LinkId=84895).
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